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Preface 

The Oracle documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology 

Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html) contains the 
latest versions of the Oracle Agile EDM PDF files. You can view or download these manuals from 
the Web site, or you can ask your Agile administrator if there is an Oracle Documentation folder 
available on your network from which you can access the documentation (PDF) files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or 
later. This program can be downloaded from the Adobe Web site 
(http://www.adobe.com). 

 

Note Before calling Agile Support about a problem with an Oracle Agile EDM manual, please 
have the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Oracle Agile EDM can be found in the Release Notes file on the 
Oracle Technology Network (OTN) Web site 
(http://www.oracle.com/technology/documentation/agile_eseries.html) 

Oracle Training Aids 

Go to the Oracle University Web page 
(http://www.oracle.com/education/chooser/selectcountry_new.html) for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

Accessibility of Links to External Web Sites in Documentation  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.

http://www.oracle.com/technology/documentation/agile.html
http://www.adobe.com/
http://www.oracle.com/technology/documentation/agile_eseries.html
http://www.oracle.com/education/chooser/selectcountry_new.html
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Chapter 1  

Introduction 
 

This guide describes how to install Oracle 11gR2 and adapt the Oracle database for use with    
Agile e6.1.2, running under Windows 2008 SP2 / 2008 R2 

Where to Go for More Information 

For additional information, consult the Oracle online installation and administration documentation. 

http://www.oracle.com/pls/db112/portal.portal_db?selected=11 

http://www.oracle.com/pls/db112/portal.portal_db?selected=11
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Chapter 2  

Requirements 

Hardware and Software Requirements 

Requ irement   Min imum Value  

Physical memory (RAM) Minimum 1GB 

Refer to the Hardware Sizing documentation to determine the required 
memory for your specific Oracle Server installation.  

Virtual memory Double the amount of RAM 

Disk space for software files 8 GB (8388608 KB). It could be smaller depending on the components 
chosen to be installed. 

Disk space for database files Refer to the Hardware Sizing documentation to determine the required 
space for the database creation. 

System architecture Processor: Intel Pentium 4 or higher/compatible 

Operating system Microsoft Windows Server 2008 SP2 64 bit. 

Microsoft Windows Server 2008 R2 64 bit. 
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Chapter 3  

Prepare the System 

1. You have to be logged on to the computer, on which the Oracle components are to be 
installed, as a member of the Administrators group.   

2. Create the directories/drives for the distribution of the data files depending on the number of 
disks prepared for the Oracle installation. For instance, if you have prepared 3 disks -  

 E:\ 

 F:\ 

 H:\ 

The drive letters E:\, F:\, and H:\ here are just an example. Subdirectories will be created later in 
these directories by the database creation (see Chapter 4). 

Download Oracle Installation Media 

1. Download and uncompress the Oracle Agile Engineering Data Management Application 
(Release e6.1.2) from the Oracle eDelivery web site (under Oracle Agile Applications->Oracle 
Agile Engineering Data Management (Release e6.1.2) Media Pack for Microsoft Windows x64 
(64-bit)). 

2. Download and uncompress the Oracle Database 11g Release 2 (11.2.0.1.0) for Microsoft 
Windows Server 2008 (part 1 and 2) from the Oracle eDelivery web site. 

3. Download and uncompress the Oracle Client 11g Release 2 (11.2.0.1.0) (32-bit) for Microsoft 
Windows Server 2008 from the Oracle eDelivery web site (under Oracle Agile Applications-
>Oracle Agile Engineering Data Management (Release e6.1.2) Media Pack for Microsoft 
Windows x64 (64-bit). 

 
The 32-bit Oracle client must be installed on the machine where Agile e6.1.2 is installed. If Agile 
e6.1.2 and the database are installed on the same machine, the 32-bit Oracle client must be 
installed on the same machine too. 

Extracting the Installation Files 

To extract the installation archive files, change to the directory that contains the downloaded 
installation archive files. Use a GUI tool, like 7-zip, to extract the installation files. 
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Chapter 4  

Installing Oracle 11gR2 

This chapter provides instructions for installing the Oracle 11gR2 Database for use with Agile 
e6.1.2  

Start the Oracle Database 11gR2 Installation 

1. Start setup.exe from the downloaded Oracle Installation Media. 

The Configure Security Updates window opens. 

 

Note To receive notifications about security issues via e-mail, enter your e-mail address 
in the Email text field. To receive security updates from My Oracle Support, enter 
the e-mail address registered with My Oracle Support, select the I wish to receive 
security updates... option, and enter your My Oracle Support password.                                       
If you chose not to receive security updates, deselect the  I wish to receive 
security updates via My Oracle Support  check box. An  Email Address Not 
Specified  dialog box appears. Click Yes to continue 
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The Select Installation Option window opens. 

 

2. Select ‟Install database software only‟ and click Next. 

The Grid Installation Options window is opened. 
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3. Select „Single instance database installation‟ and click Next. 

Note Please note that the Real Application Cluster database installation is not a subject 
of this document! 

The Select Product Languages window opens. 

 

4. Select “English” as the language in which your product will run and click Next. 
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Note It is possible to select any other language from the list of product languages if you 
want the Oracle database to operate in a different language. Please be aware that 
the scope of translation for a given component may differ between languages, e.g. 
some translations may include all user interface text, while others may include only 
error messages and no help file! 

The Select Database Edition window opens. 

 

Note Please note that the Enterprise Edition is preset as the default database edition. 
You mustn‟t select the Enterprise Edition if you have a Standard Edition license! 

Note Please note that with an Agile e6 installation no further action regarding the 
components is necessary. However, components that are not automatically enabled 
can be enabled manually!  

Note In case you select the Standard Edition no further action is required. Simply click the 
Next button to proceed with the installation! 
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5. Click Next.  

The Specify Installation Location window opens. 

 

 

6. Specify the installation location for the Oracle base directory and the Oracle home directory. 
Click Next.  

If the Oracle base location is in the home directory, you will get the following warning message: 
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Note You can ignore the warning by clicking on Yes, but if possible avoid having the 
same directory for the Oracle base and the Oracle home directory!   

The Perform Prerequisite Checks window opens and the installer performs a prerequisite 
check. 

 

If any of the minimum requirement values are not met, the Installer lists failed checks together 
with actual and expected values. Fix them before you continue with the installation. 

You can click a Fix & Check Again button to generate a fixup script. The nodes on which 
prerequisites have failed, are listed in the Execute Fixup Script window. You can run the fixup 
script as a root user to complete the required pre-installation steps. 

If all of the minimum requirements are met, a Summary window (see below) will appear. If any 
of the requirements are not met, the failed checks will be displayed in the Perform Prerequisite 
Checks window. You will have to fix and check them again. 

Note Using fix up scripts will not ensure that all the prerequisites for installing the Oracle 
database are satisfied. You must still verify that all the pre-installation requirements 
are met to ensure a successful installation. 

When the prerequisite checks are completed, the results are listed in the Summary window. 
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7. In the Summary window, review the options you have chosen and click Finish. 

The Finish window opens. 

 

8. Click Close to finish the installation.   
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Install the Oracle Client 

Note The 32-bit Oracle client must be installed on the machine where Agile e6.1.2 is installed. 
If e6.1.2 and the database are installed on the same machine, the 32-bit Oracle client 
must be installed on the same machine too. 

1. Start setup.exe from the downloaded Oracle Client Installation Media. 

The Select Installation Type window opens. 

 

2.  Select the “Custom” type of installation” and click Next. 

The Select Product Languages window opens. 
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3. Select “English” as the language in which your product will run and click Next. 

The Specify Installation Location window opens. 

 



Installation Manual for Oracle 11g on Windows for Agile e6.1.2  

 

Chapter 4 - 16 Oracle® Agile Engineering Data Management 

 

 

4. Specify the installation location for the Oracle base directory and the Oracle home directory. 
Click Next. 

The Available Product Components window opens. 

 

5. Select the following components to install (as depicted in the image above) and click Next. 

 Oracle Database Utilities 

 Oracle Java Client 

 SQL*Plus 

 Oracle JDBC/THIN Interfaces 

 Oracle Call Interface (OCI) 

 Oracle Programmer 

 Oracle Net 

The Perform Prerequisite Checks window opens and the Installer performs the requisite 
checks. 
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If any of the minimum requirement values are not met, the Installer lists failed checks together 
with actual and expected values. Fix them before you continue with the installation. 

The nodes on which prerequisites have failed, are listed in the Execute Fixup Script window. 
You can run the fixup script as a root user to complete the required pre-installation steps. 

If all of the minimum requirements are met, a Summary window (see below) will appear. If any 
of the requirements are not met, the failed checks will be displayed in the Perform 
Prerequisite Checks window. You will have to fix and check them again. 

Note Using fixup scripts will not ensure that all the prerequisites for installing the Oracle 
Client are satisfied. You must still verify that all the pre-installation requirements are 
met to ensure a successful installation! 

6. In the Summary window, review the global settings you have chosen and click Finish to start 
the installation. 

Ignore the warning that the Oracle Base is the Oracle home directory (if you decided to place it 
there). 

7. Click Next to proceed to the summary. 

8. In the Summary window, review the options you have chosen and click Finish. 
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When the installation is finished, a Finish window is opened. 

 

9. To finish the installation click Close. 
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Database Creation 

The database will be created by using the Database Configuration Assistant (DBCA) templates. 
DBCA templates include database options, initialization parameters, and storage information for 
data files, table spaces, control files and redo logs. 

Five different templates are predefined to meet different requirements according to purpose, size 
and number of the users of the Agile e6.1.2 database installation. 

Refer to the Hardware Sizing Recommendation for Agile e6.1.2 document for additional information 
on significant database parameters and settings of each template.   

1. Refer to the downloaded media pack - Oracle Agile Engineering Data Management Application 
(Release e6.1.2). All templates are in the addon/db/windows/templates directory. 

2. Copy the DBCA template file (e.g. plm_prod_medium.dbt) to the 
%ORACLE_HOME%\assistants\dbca\templates directory. 

3. Start the Oracle Database Configuration Assistant from the Windows start menu. 

Start > All Programs > Oracle - OraDb11g_home1 > Configuration and Migration Tools > 
Database Configuration Assistant.  

Note Here and below OraDb11g_home1 is the name of the Oracle Home for Oracle database 
installation in the example. The name may be different by your installation. 

The Introduction window opens. 

 

4.  Click Next to start the database configuration. 

The Database Configuration Assistant – Operations window opens. 
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5. Select „Create a Database‟ and click Next.  

A list of different templates is provided in the Database Configuration Assistant – Database 
Templates window. Here you should also see the template that you have chosen and copied in 
step 2. 

6. Select the template you want to use and click Next. 

 

The Database Identification window opens. 
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7. Enter the global database name and database SID and click Next.  

The default SID is plm61. A good practice is to set the global database name to SID.<domain 
name> - e.g.  plm61.mydomain.com. But it can be left the same as the database SID. 

The next window provides the possibility to centrally manage the Oracle databases using 
Oracle Enterprise Manager Database Control.  

8. Select the option “Configure Enterprise Manager” and click on the Automatic Maintenance 
Tasks tab.  
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A message is displayed that a listener has to be configured first - prior to configuring the 
database by dbca.  

 

If a configured listener for this Oracle Home already exists, this warning message will be 
skipped and by clicking on the Automatic Maintenance Tasks tab, you will see the screen from 
step 18. In this case skip the steps 9-17 and continue with step 18. 

9. Click OK to close the warning message.  

10. Start the Oracle Net Configuration Assistant from the Windows start menu. 

Start > All Programs > Oracle - OraDb11g_home1 > Configuration and Migration Tools > Net 
Configuration Assistant. 

The Welcome window opens.  

 

11. Select the Listener configuration and click Next. 

12. In the next window select Add from the list and click Next. 
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13. Create the name for the listener and click Next.  

 

14. Select TCP from the Available Protocols list (selected by default) and click Next. 
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15. Select the standard port number of 1521 (or one that has not been used yet) and click Next. 

 

16. Select not to configure another listener and click Next. 
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17. Click on Next.   

 

The Listener configuration is completed. 

18. Make sure that you have enabled automatic maintenance tasks and click Next. 
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The Database Credentials window opens. 

 

19. Enter passwords for SYS, SYSTEM, SYSMAN and DBSNMP and click Next.  

It is highly recommended to use different passwords for these accounts.  

The Database File Location window opens. 
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20. Select „Use Database File Locations from Template‟. 

21. Click the „File Location Variables…‟ button. 

The File Location Variables window opens. 
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22. Enter value for the variables in the table.  

As values you should provide the directories created in Chapter 3 (in this example E:, F:, H:). 
DBCA will create the subdirectory plm61 in the directories where the database data files will be 
created. See the table for detailed information on predefined file destination variables. 

 

Variable  Descript ion  

ORADATA1 Directory for data files of tablespaces EDB, EDB_LOB, EDB_TMPIDX 

ORADATA2 Directory for data files of tablespaces EDB_IDX,  EDB_TMP 

ORADATA3 Directory for data files of temporary tablespace TEMP 

ORADATA4 Directory for data files of undo tablespace 

ORADATA5 Directory for data files of tablespaces SYSTEM, TOOLS, USERS 

ORAARCH Directory for Archive log files 

REDO1 Directory for redo log files 

REDO2 Directory for redo log files 

 

Follow the instructions below to set the value for variables by different number of disks. 

 Number of disks: 1 (there is only one directory – e.g. /data1) 

Disk1: ORADATA1, ORADATA2, ORADATA3, ORADATA4, ORADATA5, REDO1, REDO2, 
ORAARCH – all variables will be set to /disk1 

 Number of disks: 2 (there are two directories – e.g. /data1, /data2) 

Disk1: ORADATA1, ORADATA4, ORADATA5, REDO1 – they get the value of /data1 

Disk2: ORADATA2, ORADATA3, ORAARCH, REDO2  – they get the value of /data2 

 Number of disks: 3 

Disk1: ORADATA1, ORADATA5 

Disk2: ORADATA2, ORADATA4, REDO1 

Disk3: ORADATA3, ORAARCH, REDO2 

 Number of disks: 4 

Disk1: ORADATA1, REDO1 

Disk2: ORADATA2, REDO2 

Disk3: ORADATA3, ORAARCH 

Disk4: ORADATA4, ORADATA5 

 Number of disks: 5 

Disk1: ORADATA1, REDO1 

Disk2: ORADATA2, ORAARCH 

Disk3: ORADATA3, ORADATA5 

Disk4: ORADATA4 

Disk5: REDO2 

 Number of disks: 6 
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Disk1: ORADATA1 

Disk2: ORADATA2, ORAARCH 

Disk3: ORADATA3 

Disk4: ORADATA4 

Disk5: ORADATA5, REDO1 

Disk6: REDO2 

 Number of disks: 7 

Disk1: ORADATA1 

Disk2: ORADATA2 

Disk3: ORADATA3 

Disk4: ORADATA4 

Disk5: ORADATA5, ORAARCH 

Disk6: REDO1 

Disk7: REDO2 

 Number of disks: 8 

Disk1: ORADATA1 

Disk2: ORADATA2 

Disk3: ORADATA3 

Disk4: ORADATA4 

Disk5: ORADATA5 

Disk6: ORAARCH 

Disk7: REDO1 

Disk8: REDO2 

23. Click OK and then Next. 

24. Deselect the option Specify Flash Recovery Area in the next window.  
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Depending on your backup strategy and used template, archiving can be enabled. 

Note For a productive database it is highly recommended to archive the database. The 
destination of the archive directory can be specified by clicking on the Edit Archive 
Mode Parameters button (predefined by the variable ORAARCH). 

25. Click Next.  

The next window provides database features as well as the possibility to run custom scripts 
after the database creation. It is not recommended to change the settings provided by the 
template.  

 

26. Click Next. 

The next window provides different database parameters. You can navigate to the setting of 
memory, character sets, database sizing, and connection mode. Usually all parameters are set 
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by the selected template and you don‟t need to change them, but experienced users can 
modify some parameters depending on the database size and number of users. 

 

27. Click Next. 

The Database Storage window shows table space, data files, control files and redolog 
groups/files to be created.  

28.  

 

29. Click Next. 

The Creation Options window opens. 
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30. Select “Create Database”, “Save as a Database Template” and “Generate Database Creation 
Scripts” and click Finish. 

A summary of the database parameters is displayed. 
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31. Click OK.  

The database creation process is started. 

32. When the database creation is done, click Exit to finish the process. 

Configuring tnsnames.ora and sqlnet.ora  

1. Start the Oracle Net Manager 

2. Start ->All Programs-> Oracle - OraDb11g_home1->Configuration and Migration Tools->Net 
Manager 

3. Expand the view for Local and click on Profile. 

 

4. Enter your domain name in the field Default Domain. 

5. Save the configuration by clicking on File->Save Network Configuration from the main menu 
and exit the Net Manager by clicking on File->Exit. 

6. Start the Oracle Net Services Configuration Tool. 

Start -> All Programs-> Oracle - OraDb11g_home1->Configuration and Migration Tools->Net 
Configuration Assistant 

7. Select the Local Net Service configuration and click Next. 
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8. Select Add and click Next. 

 

9. Enter the Service Name. This is the global database name you provided by the database 
creation. In the example it is plm61.domain.com. Click Next. 
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10. Select the TCP protocol and click Next. 

 

11. Enter the fully qualified machine name – where the Oracle database is located and click Next. 
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12. Select not to perform a test and click on Next. 

 

13. Finally, select the Net Service Name and click Next. 
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14. Select not to configure another service and click Next. 

  

15. The Net service name configuration is completed. Click on Next and then on Finish to quit. 
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16. Test the database connection with the following command:  

sqlplus system@plm61/<SYSTEM password> 
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Chapter 5  

Modify the Oracle Database 

Create Directories for the Oracle Data Pump 
Utility 

1. Create a directory which will be used for the Oracle Data Pump Export/Import Utility with two 
subdirectories - system and user (for instance d:\ora_dmp\system; d:\ora_dmp\user). 

2. Open a sqlplus session and connect as „system‟. 

sqlplus system/<system password> 

3. Run the script ddl_pump_dir.sql which is located in the addon/db/sql directory within the 
downloaded Oracle Agile Engineering Data Management Application (Release e6.1.2) 
package.  

SQL>@<full path to the file ddl_pump_dir.sql> 

4. Enter the path to the main directory created under step 1 (for instance d:\ora_dmp). 

The script will create two directory objects – one for system users and one for normal users 
and will give rights for the second directory to user PLM. 

Create a Database User and Role 

You will need to create the Agile e6.1.2 database user and role and provide the necessary 
privileges and quotas. You can do this using the following commands or using the Oracle 
Enterprise Manager Database Control as described in the section below. 

You can create AGILE_E_ROLE role and plm schema also by executing the script cre_plm_usr.sql 
in the directory …/addon/db/sql. 

SQL>@<full path to the file cre_plm_usr.sql> 

Username (e.g. PLM) and password have to be provided. 

Using SQL to Create a Role 

1. Check if the plm role exists – open sqlplus session, connect as SYS or SYSTEM and execute 

select role from dba_roles where role=’AGILE_E_ROLE’; 

2. If string „AGILE_E_ROLE‟ is returned, the role exists. Then skip the role creation and continue 
with the user creation. Otherwise, the role has to be created. 

3. Use the sql code below to create the role AGILE_E_ROLE: 

CREATE ROLE AGILE_E_ROLE; 

GRANT CONNECT TO AGILE_E_ROLE; 

GRANT CREATE TABLE TO AGILE_E_ROLE; 

GRANT CREATE VIEW TO AGILE_E_ROLE; 

GRANT CREATE SYNONYM TO AGILE_E_ROLE; 

GRANT CREATE DATABASE LINK TO AGILE_E_ROLE; 
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GRANT CREATE SEQUENCE TO AGILE_E_ROLE; 

GRANT ALTER SESSION TO AGILE_E_ROLE; 

GRANT CREATE PROCEDURE TO AGILE_E_ROLE; 

GRANT CREATE TRIGGER TO AGILE_E_ROLE; 

GRANT ALL ON DIRECTORY ORA_DMP TO AGILE_E_ROLE; 

Using SQL to Create a User 

1. Use the sql code below to create the plm schema  (named, e.g. PLM): 

CREATE USER PLM 

IDENTIFIED BY <PASSWORD>  

DEFAULT TABLESPACE "EDB"  

TEMPORARY TABLESPACE "TEMP"  

PROFILE DEFAULT  

QUOTA UNLIMITED ON "EDB"  

QUOTA UNLIMITED ON "EDB_IDX"  

QUOTA UNLIMITED ON "EDB_TMP"  

QUOTA UNLIMITED ON "EDB_TMPIDX"  

QUOTA UNLIMITED ON "EDB_LOB"  

ACCOUNT UNLOCK; 

GRANT "AGILE_E_ROLE" TO PLM; 

ALTER USER PLM DEFAULT ROLE AGILE_E_ROLE; 

 

Using Enterprise Manager Database Control to Create a User 

1. Start the Enterprise Manager Database Control.  

By default it can be invoked on https://localhost.localdomain:1158/em/console, but it can be 
configured manually to use another port. DB Control port and url can be found by checking the 
status of the DB Control: 

emctl status dbconsole 

 

Oracle Enterprise Manager 11g Database Control Release 11.2.0.1.0 

Copyright (c) 1996, 2010 Oracle Corporation.  All rights reserved.  

https://hostname:port/em/console/aboutApplication 

…. 

2. Enter your user credentials and click Login.  

 

https://hostname:port/em/console/aboutApplication
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3. Click on the Server tab and in the Security section on Users.  

4. Click Create. 

 

5. Click on the General tab and insert a user name and password and assign default and 
temporary table space. 

6. In the Roles tab click Edit List.  

7. Select the role AGILE_E_ROLE from the list with available roles and click Move. 

The role is moved to the Selected Roles.  

8. Click OK.  

 

The role AGILE_E_ROLE should have been created in the previous step. 

9. Open the Quotas tab and assign unlimited quota to EDB, EDB_IDX, EDB_LOB, EDB_TMP 
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and EDB_TMPIDX. 

 

10. Click OK to finish the database user creation. 

Import the Database Dump 

Import the Agile e6.1.2 dump using the following commands, and then check the log file for errors. 
Make sure that the variable NLS_LANG is set to AMERICAN_AMERICA.WE8MSWIN1252. 

Check the registry for the value of the variable NLS_LANG - 
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_<11gR2 installation> 

imp username/pass@plm61 file=plm61.dmp log=plm61.log buffer=500000 

commit=y statistics=none full=y 

username, pass are the name and the password of the user you created in 

the database. 

 

commit=y Rollback segments cannot get too small 

statistics=n No statistics will be created 

buffer=500000 Necessary for lobs, better performance 

full=y  Iimports full dump even if the dump was exported by different user 

 

Compile All Invalid Objects in Schema PLM 

After importing the Agile e6.1.2 dump some objects might be invalid. This can be verified by the 
following way: 

1. Open a sqlplus session and connect as „sys‟ – as sysdba. 

sqlplus sys/<sys password> as sysdba 

SQL>select count(*) from dba_objects where status <> ’VALID’ and 

owner=’PLM’; 

If the returned message is „no rows selected‟, then you have no invalid objects.  
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2. Otherwise, execute the script utlrp.sql.– the script will compile all invalid objects in the 
database. 

SQL> @?/rdbms/admin/utlrp.sql 

3. Verify once again that there are no invalid objects: 

SQL>select count(*) from dba_objects where status <> ’VALID’ and 

owner=’PLM’; 

Gather Statistics 

In Oracle 11gR2 the default value for the OPTIMIZER_MODE initialization parameter is 
ALL_ROWS, which means that a cost-based approach will be used for all SQL statements. Oracle 
highly recommends creating statistics in order to avoid performance losses. This should be done 
after the dump import and has to be repeated periodically. 

 Calculate statistics of all tables and indexes in db schema PLM: 

SQL> EXECUTE DBMS_STATS.GATHER_SCHEMA_STATS('PLM',CASCADE =>true); 

 Calculate statistics of all tables and indexes in db schema PLM with 5% of the rows: 

SQL> EXECUTE DBMS_STATS.GATHER_SCHEMA_STATS('PLM', estimate_percent => 

5, CASCADE =>true); 

 Drop all statistics of PLM schema objects. Optimizer is now running in rule mode. 

SQL> EXECUTE DBMS_STATS.DELETE_SCHEMA_STATS('PLM'); 

For all schema objects, statistics have to be available to support the cost based optimizer. If 
tables and indexes are modified or created, statistics must be established. 

 Calculate statistics on all tables without statistics and their indexes in db schema PLM with 5% 
of the rows: 

SQL> EXECUTE DBMS_STATS.GATHER_SCHEMA_STATS(ownname => 'PLM',options 

=> 'GATHER EMPTY', estimate_percent => 5, CASCADE =>true);  

 Calculate statistics on tables t_master_dat and their indexes in db schema PLM with 10% of 
the rows: 

SQL> exec sys.dbms_stats.gather_table_stats(ownname=> 'PLM', tabname=> 

'T_MASTER_DAT', partname=> NULL , estimate_percent=> 10 ,cascade=> 

true); 

 

Note Statistic information can be viewed, e.g. in user_tables and user_indexes. These views 
provide information about average width of the row and number of rows. 

Uninstall Oracle for Windows  

It is not possible to uninstall the Oracle 11gR2 database with the Oracle Universal Installer shipped 
with 11gR1 or an earlier version. 

Oracle 11gR2 comes with a deinstallation utility. If you want to uninstall Oracle 11gR2, start the 
script deinstall.bat in the directory %ORACLE_HOME\deinstall. The script may need to be run as 
Administrator. 
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4. Specify all single instance listeners that are to be de-configured as well as database names 
that are configured in this Oracle home. Finally, confirm the deinstallation with „y‟.  

The $ORACLE_HOME directory will be deleted after de-installation. 

5. If you have an improper Oracle installation, a second installation will fail. You have to uninstall 
Oracle and then try from the beginning.  

Troubles during Database Creation 

When having troubles with the database creation, check the following:  

 Database creation logs: %ORACLE_BASE%\cfgtools\dbca\<db name> 

 Instance Parameter file: %ORACLE_BASE%\admin\<db name>\pfile\init.ora 

 Instance SPFILE: %ORACLE_HOME%\dbs\spfile<db name>.ora 
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 Database Diagnostics: %ORACLE_BASE%\diag\rdbms\<db name>\<db name> 

 Network configuration: %ORACLE_HOME%\network\admin\*.ora 
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